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Inspiration Software Updates
365 days a year!Pure Inspi

ration

“Embroidery Tool Shed” Version 24.40 (04/05/2024)
--------------------------------------------------------------------------------
What you will find in this update: 

Bug Fix for Mac Printing

In this new version we fixed the bug with “MacOS Sonoma” dealing with printing. We are now able to 
print with version ETS 24.40 when using version 6 of Dime Translator.

All that needs to be done is, install the latest version of ETS. If you’re using ETS on the Mac, the software 
will look at what version of the “Dime Translator” you’re using. If you’re using a version below version 6, 
ETS will alert you to download the Dime Translator.

If you would like to download it before installing ETS

Dime Translator Version 6 (Macintosh Utility)

https://inspiredbydime.sw-update.net/EmbXPortSetup.pkg
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“Embroidery Tool Shed” Version 24.37 (04/01/2024)
--------------------------------------------------------------------------------
What you will find in this update: 

1. Wireless to machine Icon change

2. New Thread Charts

• Exquisite ColorPlay Brighton - Sherbet

• Exquisite ColorPlay Capetown - Flamingo

• Exquisite ColorPlay Carlsbad - Sunset

• Exquisite ColorPlay Carmel - Citrus

• Exquisite ColorPlay Chicago - Jewel Tones

• Exquisite ColorPlay Dublin - Meadow

• Exquisite ColorPlay Logan - Summer Berries

• Exquisite ColorPlay Madison - Pansy Patch

• Exquisite ColorPlay Miami - Cotton Candy

• Exquisite ColorPlay Monterey - Fresh

• Exquisite ColorPlay Nashville - Denim Blues

• Exquisite ColorPlay Paris - Amberglow

• Exquisite ColorPlay Provence - Purple Passion

• Exquisite ColorPlay Rio - Carnival

• Exquisite ColorPlay Santorini - Blue Ocean

• Exquisite ColorPlay Savannah - Pastels

• Exquisite ColorPlay Seattle - Forest

• Exquisite ColorPlay Sedona - Desert Canyon

• Exquisite ColorPlay Transylvania - Halloween
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3. Updated all variegated thread to new formula.

• Exquisite Medley

4. Edge-to-Edge Quilting

• Naming convention fixed for “E2E Bonus Pack”

• We have reduced the 10 inches body internal restriction to 4 inches.

• Minor adjustment between body designs.

5. Release “Embroidery Special Effects”

New Software title.
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“Embroidery Tool Shed” Beta Version 18.68 (01/22/2024)
--------------------------------------------------------------------------------

What you will find in this update: 
1. Active software’s with in ETS.

When the customers activate any of our software’s titles and ICON becomes active to the right. Until recently 

this has become a bit confusing. (At least for me) So we have changed the icon to match what can be found 

in the shopping cart.

 
2. Send designs to Brother / Babylock machines wirelessly.

Works in everything SW with the exception of ETS and MFD.

Now it works:

1. You will find a machine ICON at the top.

a. You must have a design open.

2. This will bring up the Machines interface.
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3. Clicking on the Edit button you can set up your machine by inputting the IP address and changing 

the name.

a. Also, you can find a new search button that should show you a list of IP addresses available

on your network.

 
NOTE:

1. Using Windows: This will show every IP on your network. Look for the one labeled 

“Brother Embroidery Machine.”

2. Using Mac: You will not see the name to the right of the IP. Best to check your sewing machine’s

IP manually.

Refer to your sewing machine’s manual for these instructions.
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3. You can add mutable machine by clicking New.

 
3. Release of Embroidery Tool Shed Plus

a. This is a purchasable module.

b. All the features of ETS plus lettering (17 fonts)

Bauhaus, Casual, Arial, Ribbon Love, Brush

Cap_Scr, Cursive, Diana, CurlyQ

Amgothicg, Centuri2, Athletic, VARSITY PUFF

Arial Applique, Round Monogram, Interlocking, and Fishtail

4. Release of Edge-to-Edge Quilting

    Note:

a. This is a purchasable add on to My Quilt Planner module.

b. Must have an activated version of My Quilt Planner to have “Edge-to-Edge Quilting” appear for

sale and activation.
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“Embroidery Tool Shed” Beta Version 18.46 (08/22/2023)
--------------------------------------------------------------------------------

What you will find in this update:
“Window app Microsoft-Verified App” warning.

In the latest windows update in August of 2023.

(Example:  Window 10 home: Version 22H Build 19045.3324 on 08/18/2023)

You may get a warning when installing ETS.

“The app you’re trying to install isn’t a Microsoft-verified app”

This is Microsoft’s attempt to have everyone to use their app store.  Instead of normal installation process. 

To change this “Recommendation Settings” 

1. Click on “Change my app recommendation settings”

2.	 Click on “App & features”
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3.	 Choose “Anywhere” 

4.	 Close window

5.	 Re-install ETSSetup.exe

MacOS Version Sonoma

This new version of ETS is compatible with Sonoma.  The new version of MacOS (available in late September.)

To be able to have this new version to work, you will need to download and install a new version of 
Dime Translator.  This New version can be downloaded in two ways.

1. Install ETS version 18.46 or above.  When this version runs on the Mac, it will look see what version 
of Mac Translator is running and if you are running an old version, it will ask you to download and 
install a new version.

2. Download and install “Dime Translator Version 50” 

https://inspiredbydime.sw-update.net/EmbXPortSetup.pkg

Bug Fix

When using mac’s and selecting a manual to review.  The manual loads corrupted.  This has been fixed. 

https://inspiredbydime.sw-update.net/EmbXPortSetup.pkg
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“Embroidery Tool Shed” Beta Version 18.41 (07/05/2023)
--------------------------------------------------------------------------------

What you will find in this update:
My Quilt Embellisher and My Block Piecer

Block Updates.

Block Additions.  “Accuquilt Compatible”
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Word Art in Stitch

1. New Feature:  Nap Blocker

Bug Repair:

Font:  

Cust_Scr  number “8”

Monogram Pruffy “L”
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“Embroidery Tool Shed” Version 18.38 (06/07/2023)
--------------------------------------------------------------------------------

What you will find in this update:
Click n Stich.

1. Update to shaping issues (subtract, crop, trim) with the horizontal stripes.

“Embroidery Tool Shed” Version 18.37 (06/06/2023)
--------------------------------------------------------------------------------

What you will find in this update:
1. Hoops

a. Some updated hoops

b. New Dime Monster Hoops add.
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c. New Bernette b70 hoops.
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“Embroidery Tool Shed” Beta Version 18.35 (05/04/2023)
--------------------------------------------------------------------------------

What you will find in this update:

Release of “Cut N Stitch” software.

“Embroidery Tool Shed” Beta Version 18.33 (04/24/2023)
--------------------------------------------------------------------------------

What you will find in this update:

1. Reported 04/06/2023…  “Workflow with foundation piecing”

    Mac issue using My Block Piecer and workflow.  The numbers not showing in preview. 

    Fixed.

“Embroidery Tool Shed” Beta Version 18.27 (03/21/2023)
--------------------------------------------------------------------------------

What you will find in this update:

1. This build reads a new version of SVG correctly.
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“Embroidery Tool Shed” Beta Version 18.25 (02/20/2023)
--------------------------------------------------------------------------------

What you will find in this update:

1. Preview button in Design Open dialog – work on both Windows & MacOS.

2. The panels on the right are collapsible now.
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3. Setting in General Options -> View for using realistic and default view  
    (request from creatricesbroderiemachine.com).

4. Realist view is improved in large scales – good for demos.

5. Fixed the “Convert to outlines” setting not preserving in Open Dialog.

6. Fixes a problem with the highlighted selection.

http://creatricesbroderiemachine.com
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7. The old Open & Save dialogs have been replaced with the new modern ones.

a. It might not look like there was much of a change.

i. But it will show all extensions when selected. (we have a lot, so it could be long)

ii. And work better on hi resolution displays, The old one was WinXP compatible –since we no longer 
support XP it was time to update them

8. Font fix:

a. “Feltip” font the lowercase “n” looked the same as the lowercase “u”. has been fixed.

9. Easier and more accurate selection of satin paths (no need to click on the edges only) and 
overlapping paths (sometimes it used to select the ones behind)

10. Improved dark and bright color shades in realistic view. For example, the black color looks 
deep dark instead of dark gray.

11. The Sending to MFD button has been removed. Now you can use the dialog to export as PNG.

12. New Minimum System Requirements for PC:
Minimum System Requirements:

Windows 10
Processor: 1 gigahertz (GHz) or faster or SoC.
RAM: 2 GB (64-bit)
Free hard disk space: 16 GB.
Graphics card: DirectX 9 or later with WDDM 1.0 driver.
Display: 800 x 600
Internet access.
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“Embroidery Tool Shed” Beta Version 17.31 (11/14/2022)
--------------------------------------------------------------------------------

What you will find in this update:

1. Support for PES 10.2
2. The French translation change in Outlines message.
3. Basic Block update for MBP and MQE.

“Embroidery Tool Shed” Beta Version 17.21 (07/25/2022)
--------------------------------------------------------------------------------

What you will find in this update:

1. Bug fixed with My Block Piecer “Reorder”.
2. Two new PAM styles added.
3. PSV manual support added.
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“Embroidery Tool Shed” Beta Version 17.20 (07/18/2022)
--------------------------------------------------------------------------------

What you will find in this update:

1. New free designs for “Stitch Viewer”
Note:  Like before….  All design found in “C:\dime\Designs” as part of ETS install is Not protected.
will be available to everyone.
C:\dime\Designs\Perfect Stitch Viewer Free Designs\Sewing Notion Sketches\



Inspiration Software-Updates

19

2. Update to “My Quilt Embellisher”
When selecting the “Quilt Block” Icon we have added a new folder called. “Mosaic Tile”
In the folder you will find four special block that you can load and embellish.
Thing to make note of:

a. These four blocks will not resize to fit within a perfect square like all other block do by default. 
	 It will keep it default size saved.

b. If you wish to make additional “special” block like the four found in the install, you will need to 
add the following label <Fixed Size Block> into design notes:
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3. Design Catalog utility that takes a folder with .c2s files and creates .csv output.
To run this utility in ETS, press Alt+Shift+Ctrl + F10, navigate to directory with c2s files and click on ok.

Fonts….. 
The following characters   “à â ä ç é è ê ë î ô ö ù ü û”  have been added to.

Albany, Amgothic, Antero, Arcade, Arial Central Run, Arial Run, Athletic, Audrey,
Baushaus, Benquiat, Block_C, Block_O, Bolatin, Bordeaux, Bragg, Bridgeton,
Brittany, Brushg, Cap_Scr, Centuri2, Cent_Sm, Cola, Colorplay, Comm_Scr,
Com_Masbro, Com_Mnhasw1, Com_Mnmodbw1, Com_Pfsswmn, Cursive,
Curt_Scr, Dallas, Easy_Scr Small, Easy_Scr, Eleg_Scr, Eurob Small, Eurob,
Fan_Scr, Fast_Scr, Felttip Small, Felttip, Fitzgerald, Fox, Giddyup, Goudy_Oe,
Helc, Ho2, Indu_Scr, Jester Pro, Lovina, Mandevilla, Meister, Mel_Scr, Metro,
Mg-Block, Mg-Newwave, Mg-Style51ascript, Mnhb-2, New Brington, Newwave Small,
Newwave, Officeb, Pearl Small, Pearl, Pepita, Philly, Raven Script, Ribbon Love, Rodeo,
Roman_Sm, Rope, Seaside, Sedr_Scr, Simp_Scr, Stuyvest, Teknoidb, Trad_Scr, Universi,
Veljovic, Waffle, Whassi_C Small, Whassi_C, Wingtips, Wonton, Yankee, Zaph
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“Embroidery Tool Shed” Version 16.53  Release 02/22/2022
--------------------------------------------------------------------------------

What you will find in this update:

1. New font pack has been added for purchase.
Font Pack 06 “Luxury Font Collection”
“Luxury Font Collection” is a new font pack that will be sold separately and doesn’t come with WAS.

Fonts:

Monogram
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2. Perfect Embroidery Pro, My Quilt Embellisher, My Block Piecer, My Lace Maker, Patch Applique Maker
New Feature:
We added the following new features: Joins, Fill Area to “Create Outlines”

3. Word Art in Stitch
1. Added \Kitchen\Icons\Kitchen-55.ldf  to Bubble Text Shapes

2. If a font has special characters associated with it.  You can be access with the   …

3. Font instructions for All Micro, Puffy, and  Applique
Also Mylar Serf and Shadow Work. You can be access with the   …
shown above



Inspiration Software-Updates

23

4. New fonts
Micro:

Micro Monogram (2)

Micro Font (8)

Monogram: (4)
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Fonts: (2)

Special Working Fonts: (29)
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5.  “Text on Path” and  “Path Shapes”:

“Text on Path” doesn’t work any different than it has in the past.  With the exception we have added 
and ICON to the interface.

You can select a path by click on “Shapes” icon then “Path” or create your own. (Still works with right 
mouse button click at before)

Example:
1. Place a line of text in your workspace “LOVE”.
2. Create or select the desired path.

3. Select both objects.

4. Click on “Text on Path” ICON .
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6.  Envelopes:

“Envelopes” doesn’t work any different than it has in the past.  With the exception we have added and 
ICON to the interface.

You can select a path by click on “Text” on the screen and click on the desired envelope. (Still works 
with right mouse button click at before).

7.  Warp:

“Warp” has four mode you can use.

Perspective High

Perspective Low

Wave
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Sphere

Make note:
When using any one of the 4 options show above.  When selected in text move. 
The green control node will allow you to change the letter output.

Example:  WAVE

1. Bottom green control dot will let you control the wave by moving it left and right
2. Left side green control dot will let you control the wave vertical height
3. Top green control dot will let you control the wave horizontal distortion.

Example:  Sphere

1. Bottom green control dot will size the sphere, larger or smaller.
2. Left side control dot will let you control the rap around the sphere up and down.
3. Top green control dot will let you control the rap around the sphere left and right.
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8.  Monogram Wizard

This work just like we did in PAM.  Just with different templets.

This is just a sampling of what your will find….

And many more…….



Inspiration Software-Updates

29

Embroidery Tool Shed Version 16.23 (10/23/2021)
--------------------------------------------------------------------------------

What you will find in this update:

1. ETS (All)
a. Added more help video URLs links to the software.
b. Small bug with video links fixed.
c. The PHC files you sent me in a couple of emails sometimes ago, are supported now.
d. The bug with the slow redraw that was showing wrong zig-zag is fixed.

2. Patch Applique Maker

a. Add to new styles you sent for the Merrow Patch has been added.
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b. We have added Mimic Merrow (M-Merrow) stitch type to the applique function.

3. My Quilt Planner 
a. The issue with the Miter frame in MQP has been fixed – it will work on new quilts only.

Before:     After: 

b. Fix bug with the overlap in the corners.
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Embroidery Tool Shed Version 16.12 (09/10/2021)
--------------------------------------------------------------------------------

(06/30/2021)

What you will find in this update:

PES Bug
Eileen brought to my attention that some of her PES designs where not loading into the Brother 10-needle.
With the file she provided me, we found out it was related to some of the work we have been doing with
“Patch and Applique Maker”, this has been fixed.

My Quilt Embellisher and Block Piecer
Ashley brought to my attention a feature that somehow dropped out of the software at some point in the
past and no one caught it. With a bit of research I was able to find a version that had it and get it back
into the software. The feature we lost and now is back. Is the Backdrop tool when working on a block.

After selecting a block
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Click on Backdrop tool

This will make a copy of the block and add it to the background allowing you to keep the block colored.

This can be turned off and on by click on “Backdrop” Ctrl-B 
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My Quilt Planner
Ashley brought to my attention that we had an exact math problem in My Quilt Planner
This has been fixed. Explanation of the bug is below.

1. If you sent the numbers, I have below and click on ok

Add a design and 
	 Center Cell.. them
	 Fit to Cell you get the following.

This has been fixed.
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2. Exporting Quilt  

     Ashley brought to my attention that we had a printing (PDF) problem when the user build their quilt 
choosing either ShortE, Weightless Quiter, or Edge to Edge.

This has been fixed. Explanation of the bug is below.

The error happened on the third page of attached PDF. There is no number directions. Just a black square.
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This has been fixed

(06/16/2021)

What you will find in this update:
1. Melco EXP format

a. When saving to .exp format it will also create an .inf file with color information.
2. Lettering supports check spelling.

Window only… Sorry not for the Mac.



Inspiration Software-Updates

36

(05/26/2021)

What you will find in this update:
1. Perfect Stitch Viewer

a. Print Catalog feature missing.

(05/14/2021)

What you will find in this update:
1. My Quilt Planner 

	     Bug fix with “My Quilt Planner” on Mac
a. (Karen LaMendola )

the letters and numbers that correspond with the cells you are going to quilt are not showing up
b. (Ashley Jones)

i. Border Fixed. Quilt disappearing due to the Math thing
ii. Second part was not a problem, need to group
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Embroidery Tool Shed Version 15.75 Beta (05/03/2021) update notes.

--------------------------------------------------------------------------------

What you will find in this update:
1. The ‘Special Motifs’ are back in MQE symbols.
2. Also the following thread charts have been renamed

a. Robison Anton Polyneon -> Robison Anton Super Brite
b. Marathon Polyneon -> Marathon Polyester
c. Melco ARC Polyneon -> Melco ARC
d. Sulky Polyneon -> Sulky Polyester

‘Polyneon’ is used in Madeira brand only.

Embroidery Tool Shed Version 15.73 Beta (04/28/2021) update notes.

--------------------------------------------------------------------------------

What you will find in this update:
As per our “Customer Support Meeting” of 04/27/2021 I was able to do the following.

1. At the end of the install, I have changed the URL to:https://www.inspiredbydime.com/success/

2. The Registration / Activation portion of the software has been updated.
The Registration Number and Activation Code are hidden by default now.
If you click on ‘Register Now’ and the internet connection fails, it will show up the 2 hidden controls.

https://www.inspiredbydime.com/success/ 
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Embroidery Tool Shed 15.62 (03/26/2021)
--------------------------------------------------------------------------------

What you will find in this update:
Icon / feature base video Links
This new feature will give the user the ability to watch a video tutorial on the Icon if available.
How it works? 

1. If a video is linked to the Icon, all you must do is hover over the icon and you will see.
a. Name and Short cut if available 
b. Small description of feature
c. “Press F2 for video”

2. Once you press the F2 it will launch the URL to the location of the video

3. If there is no video attached to the icon….  It will only show:
a. Name and Short cut if available
b. Small description of feature

Quilt Planner:
a. 2 new Quilt Planner workflows have been added.

i. Weightless Quilter
ii. Edge to Edge
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Install
1. New addition to the “Embroidery Tool Shed” install.   

a. After the user downloads and starts the install procedure, just before the install finishes, 
the installer will launch the URL below.

https://www.inspiredbydime.com/new-software-installation-instructions/

French
1. Update French translations
2. New French WAS manual

Bug Fix
1. Print Catalog on a MAC (Fixed)
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January, 2021
--------------------------------------------------------------------------------

What you will find in this update:
1. We have added “Save as image” and “Print Catalog“ to

Perfect Embroidery Pro  
Word Art in Stitches 
My Quilt Embellisher 
My Block Piecer  
My Quilt Planner 
My Fabric Designer 
Vintage Embroidery 
My Lace Maker  
Perfect Stitch Viewer

2. Added Exquisite Medley to thread chart. (All Software titles)

3. Macintosh. (All Software titles)

1. Compatible with Intel Mac and Big Sur 
2. New users on new M1 Mac must use version 15.45 or above.
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May, 2020
Please download version 15.14 below.

Embroidery Tool Shed 15.14 Beta (05/11/2020)
http://inspiredbydime.sw-update.net/beta/ETSSetup1514.msi

--------------------------------------------------------------------------------

What you will find in this update:
Minor Changes

All
1. All manuals have been removed from the main install and now will only be downloaded by the software 

on request. This has brought the main install down over 200 megabytes.

2. The French translation has been updated as of 05/11/2020

3. Two undated French manuals have been added. ETS / WAS

4. A request for the My Today to be used different languages. 
a. When available, if you change the language in the preference it will add the selected language 
to the ETS URL 
    i.   Example: https://theurl?language=French

PeP
1. Can now read TurboCAD version DXF format.

2. It supports the new AI 2020.

3. Tools like select, shape, stitch are significant more responsive now.

4. The lines, in input tools, ruler etc show up in a nice light blue color like in Adobe Illustrator. You can 
change this color from General Options -> View -> Accent color
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WAS
1. Bug Fix:

    a. WAS

         i.   Placement of the applique is placed at the beginning of the design.

         ii.   When saving PES, will place different color for placement and tack down. Not the same color.

Pep and Perfect Stith View
Catalog New Features

We have added a few things that have vastly improved the Cataloging feature.

New Features:

1. You can now set info either by right clicking on a folder or on a design (in library tab). The menu item 
name is ‘Set Info’. 
a. Make note: If you select the folder, it will update all files with in the folder. This is a way add keywords 
and so on to all files at once.

2. If you load a design that supports notes (c2s, hqv, hqf etc.), add/change the info and click on Apply, 
it will let you save the changes directly to that embroidery format file. Before, you had to click on 
Save As or save the file as c2s. Now it saves directly to the file loaded.

3. Keyword List 
a. These feature will look at all the files with in your catalog and give you a display of what keywords 
have been used.

Make note: The Keyword List updates it’s self after each search.
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1. The Enter triggers the ‘Find’ button

2. You can now append keywords

3. Result count

4. You can now use the ‘or’ operator in keywords. Example: stars or hearts.

----------------------------------------------------------------------------------------
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November, 2019

Inspiration update 14.29
This version update of all the Inspiration software’s is to make them compatible with MAC Catalina OS 
along with other minor bug fixes.

Installing the MAC OS, first download the latest version of the translator here:   
https://www.inspiredbydime.com/mac/

                (This must be installed first on your Mac)

After the translator is installed, download your software from: 
https://www.inspiredbydime.com/inspiration-software-download-center/

 

The download will automatically go to your Downloads folder.  Once finished click on the download icon 
and select your software.

• You can also right click the download icon and select “Open Downloads” 

o This will open a window with your downloads to double click on at ease.

Once you double-click the download, the installer will launch and guide you through the installation.  
When complete and icon will be placed on your desktop.

 

NOTE:  You MUST click on the download from the download link or double click on the download 
from the download window to launch the installer.  Simply dropping the download in the apps 
folder is NOT the same as installing.

----------------------------------------------------------------------------------------

https://www.inspiredbydime.com/mac/
https://www.inspiredbydime.com/inspiration-software-download-center/
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May, 2019

PEP; Ver. 12.92
New Features:

1. Hi-Resolution Displays:  New hi-resolution toolbar icons for 4K displays.

2. General Options:  New look to Tools/General Options:

3. Realistic view option:  (Optional) Increase double and bean run thickness in Realistic view;  
Tools/General Options/View.
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4. Default Colors:  Set default colors on a new design page:

1) File/New

2) Set Colors

3) Click on “Make Current Default”

4) Click “Yes”

5) Go to File/New, notice that the new default colors appear.

6) May also click on an empty box on the color bar for the option.

5. Print Preview:  Print Preview screen is set to “Size to Fit” as a default with a new look. 
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6. Eye is sequence view: The eye icon is darker.

7. Drag and Drop: You can Drag and Drop image file in to the center of the work field.

Note:  If you have an image on the screen like above, it will transfer to “Auto Digitizer Wizard” If selected.
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8. Hoops:  Added filtering to the Hoop feature; remove or add a check mark for the desired hoops.

9. Jumbo Hoop is now fully supported.

10. New Hoops added:

1) BabyLock-Brother 240x240

2) BabyLock-Brother 270x400

3) BabyLock-Brother 240x360

11. Trim:  A fast way to add a basic trim to the end of an object.

1) Click on object

2) Click on the “trim  Icon”

When using this feature, it will:

1) Add the trim and basic tie off to the end of  
    the selected object.

2) Add basic tie in to the next object.



Inspiration Software-Updates

49

12. Trim Branches:  A new trim function giving the user more control on how they wish the trims to be 
added.

1) Auto:  		  (default):  Trim if the stitch is longer than 20 mm.

2) Always:  	 Will always trim

3) Never:  	 Will never trim

4) Longer than:  	 User can set the distance

13. Trim, Weld, Intersect:  These three functions have been moved to “Shaping” and can be used with 
a right click when two objects are selected.
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14. Auto Save/Recover: Setup can be found in Tools/General Options/Environment and File/Recover.

To use this feature: go to File/Recover

15. Raised Satin:  adds multi layer satins on top of each other.  The default is 4.
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16. Radial Fill can be found in Complex Fill.

17. Special Files:  We have moved Inspirations special files formats out of the standard Open and Save.  
It has its own selection under File called “Special Files”.



Inspiration Software-Updates

52

18. Auto Digitizing: Improved color reduction, tracing, support for transparent PNGS, direct victor files 
(svg, ai, etc.) conversion without tracing.

You can try the new same images in c: /dime/Images (Autodigi_*.png and Vectors_*.svg)

19. Effects panel:  One click conversion to various stitch types:

20. Batch Conversion (Updated):  New Batch Conversion options, several additions including:

1) Conversion embroidery format to PNG

    Note:  it will convert in 3D realistic mode with no cross hairs

2) Select by File

3) Select by Folder
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21. New and improved curve editing:  A new mouse icon appears when editing a curve in an object 
when “Shape F9“ is selected.

22. More Efficient Editing: “Shape F9” now remains in active mode while selecting new objects for 
editing.  To return to “Select F7”, left click on Select  . 

23. New Digitizing Features: 

Important!!!!  The following digitizing features are only available if you have a registered 
version of “My Lace Maker”.

Running Stitch Type:

	 Double Rope

	 	

	 Triple Rope
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Fill Type “Grid”:

	 Single

	 	

	 Double

	 	

	 Triple
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May, 2019

MQE; Ver. 12.92
New Features:

1. Hi-Resolution Displays:  New hi-resolution toolbar icons for 4K displays.

2. General Options:  New look to Tools/General Options:

3. Realistic view option:  (Optional) Increase double and bean run thickness in Realistic view;  
Tools/General Options/View.
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4. Default Colors:  Set default colors on a new design page:

1) File/New

2) Set Colors

3) Click on “Make Current Default”

4) Click “Yes”

5) Go to File/New, notice that the new default colors appear.

6) May also click on an empty box on the color bar for the option.

5. Print Preview:  Print Preview screen is set to “Size to Fit” as a default with a new look. 
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6. Eye is sequence view: The eye icon is darker.

7. Drag and Drop: You can Drag and Drop image file in to the center of the work field.

8. Hoops:  Added filtering to the Hoop feature; remove or add a check mark for the desired hoops.
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9. Jumbo Hoop is now fully supported.

10. New Hoops added:

1) BabyLock-Brother 240x240

2) BabyLock-Brother 270x400

3) BabyLock-Brother 240x360

11. Trim:  A fast way to add a basic trim to the end of an object.

1) Click on object

2) Click on the “trim  Icon”

When using this feature, it will:

1) Add the trim and basic tie off to the end of  
    the selected object.

2) Add basic tie in to the next object.
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12. Trim Branches:  A new trim function giving the user more control on how they wish the trims to be 
added.

1) Auto:  		  (default):  Trim if the stitch is longer than 20 mm.

2) Always:  	 Will always trim

3) Never:  	 Will never trim

4) Longer than:  	 User can set the distance

13. Special Files:  We have moved Inspirations special files formats out of the standard Open and Save.  
It has its own selection under File called “Special Files”

14. More Efficient Editing: “Shape F9” now remains in active mode while selecting new objects for 
editing.  To return to “Select F7”, left click on Select  . 
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May, 2019

MBP; Ver. 12.92
New Features:

1. Hi-Resolution Displays:  New hi-resolution toolbar icons for 4K displays.

2. General Options:  New look to Tools/General Options:

3. Realistic view option:  (Optional) Increase double and bean run thickness in Realistic view;  
Tools/General Options/View.
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4. Default Colors:  Set default colors on a new design page:

1) File/New

2) Set Colors

3) Click on “Make Current Default”

4) Click “Yes”

5) Go to File/New, notice that the new default colors appear.

6) May also click on an empty box on the color bar for the option.

5. Print Preview:  Print Preview screen is set to “Size to Fit” as a default with a new look. 
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6. Eye is sequence view: The eye icon is darker.

7. Drag and Drop: You can Drag and Drop image file in to the center of the work field.

8. Hoops:  Added filtering to the Hoop feature; remove or add a check mark for the desired hoops.
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9. Jumbo Hoop is now fully supported.

10. New Hoops added:

1) BabyLock-Brother 240x240

2) BabyLock-Brother 270x400

3) BabyLock-Brother 240x360

11. Trim:  A fast way to add a basic trim to the end of an object.

1) Click on object

2) Click on the “trim  Icon”

When using this feature, it will:

1) Add the trim and basic tie off to the end of  
    the selected object.

2) Add basic tie in to the next object.
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12. Trim Branches:  A new trim function giving the user more control on how they wish the trims to be 
added.

1) Auto:  		  (default):  Trim if the stitch is longer than 20 mm.

2) Always:  	 Will always trim

3) Never:  	 Will never trim

4) Longer than:  	 User can set the distance

13. Special Files:  We have moved Inspirations special files formats out of the standard Open and Save.  
It has its own selection under File called “Special Files”

14. More Efficient Editing: “Shape F9” now remains in active mode while selecting new objects for 
editing.  To return to “Select F7”, left click on Select   icon. 
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May, 2019

WAS; Ver. 12.92
New Features:

1. Hi-Resolution Displays:  New hi-resolution toolbar icons for 4K displays.

2. General Options:  New look to Tools/General Options:

3. Realistic view option:  (Optional) Increase double and bean run thickness in Realistic view;  
Tools/General Options/View.
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4. Default Colors:  Set default colors on a new design page:

1) File/New

2) Set Colors

3) Click on “Make Current Default”

4) Click “Yes”

5) Go to File/New, notice that the new default colors appear.

6) May also click on an empty box on the color bar for the option.

5. Print Preview:  Print Preview screen is set to “Size to Fit” as a default with a new look. 
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6. Eye is sequence view: The eye icon is darker.

7. Drag and Drop: You can Drag and Drop image file in to the center of the work field.

8. Hoops:  Added filtering to the Hoop feature; remove or add a check mark for the desired hoops.
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9. Jumbo Hoop is now fully supported.

10. New Hoops added:

1) BabyLock-Brother 240x240

2) BabyLock-Brother 270x400

3) BabyLock-Brother 240x360

11. Trim:  A fast way to add a basic trim to the end of an object.

1) Click on object

2) Click on the “trim  Icon”

When using this feature, it will:

1) Add the trim and basic tie off to the end of  
    the selected object.

2) Add basic tie in to the next object.
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12. Trim Branches:  A new trim function giving the user more control on how they wish the trims to be 
added.

1) Auto:  		  (default):  Trim if the stitch is longer than 20 mm.

2) Always:  	 Will always trim

3) Never:  	 Will never trim

4) Longer than:  	 User can set the distance

13. Special Files:  We have moved Inspirations special files formats out of the standard Open and Save.  
It has its own selection under File called “Special Files”
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May, 2019

MQP; Ver. 12.92
New Features:

1. Hi-Resolution Displays:  New hi-resolution toolbar icons for 4K displays.

2. General Options:  New look to Tools/General Options:

3. Realistic view option:  (Optional) Increase double and bean run thickness in Realistic view;  
Tools/General Options/View.
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4. Default Colors:  Set default colors on a new design page:

1) File/New

2) Set Colors

3) Click on “Make Current Default”

4) Click “Yes”

5) Go to File/New, notice that the new default colors appear.

6) May also click on an empty box on the color bar for the option.

5. Print Preview:  Print Preview screen is set to “Size to Fit” as a default with a new look. 
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6. Eye is sequence view: The eye icon is darker.

7. Drag and Drop: You can Drag and Drop image file in to the center of the work field.

8. Hoops:  Added filtering to the Hoop feature; remove or add a check mark for the desired hoops.
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9. Jumbo Hoop is now fully supported.

10. New Hoops added:

1) BabyLock-Brother 240x240

2) BabyLock-Brother 270x400

3) BabyLock-Brother 240x360

11. Special Files:  We have moved Inspirations special files formats out of the standard Open and Save.  
It has its own selection under File called “Special Files”
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May, 2019

MES; Ver. 12.92
New Features:

1. Hi-Resolution Displays:  New hi-resolution toolbar icons for 4K displays.

2. General Options:  New look to Tools/General Options:

3. Default Colors:  Set default colors on a new design page:

1) File/New

2) Set Colors

3) Click on “Make Current Default”

4) Click “Yes”

5) Go to File/New, notice that the new default colors appear.

6) May also click on an empty box on the color bar for the option.
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4. Print Preview:  Print Preview screen is set to “Size to Fit” as a default with a new look. 

5. Eye is sequence view:  The eye icon is darker.

6. Drag and Drop:  You can Drag and Drop image file in to the center of the work field.
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7. Hoops:  Added filtering to the Hoop feature; remove or add a check mark for the desired hoops.

8. Jumbo Hoop is now fully supported.

9. New Hoops added:

1) BabyLock-Brother 240x240

2) BabyLock-Brother 270x400

3) BabyLock-Brother 240x360

10. Trim:  A fast way to add a basic trim to the end of an object.

1) Click on object

2) Click on the “trim  Icon”

When using this feature, it will:

1) Add the trim and basic tie off to the end of  
    the selected object.

2) Add basic tie in to the next object.
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11. Trim Branches:  A new trim function giving the user more control on how they wish the trims to be 
added.

1) Auto:  		  (default):  Trim if the stitch is longer than 20 mm.

2) Always:  	 Will always trim

3) Never:  	 Will never trim

4) Longer than:  	 User can set the distance

12. Special Files:  We have moved Inspirations special files formats out of the standard Open and Save.  
It has its own selection under File called “Special Files”
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May, 2019

VE; Ver. 12.92
New Features:

1. Hi-Resolution Displays:  New hi-resolution toolbar icons for 4K displays.

2. General Options:  New look to Tools/General Options:

3. Realistic view option:  (Optional) Increase double and bean run thickness in Realistic view;  
Tools/General Options/View.
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4. Default Colors:  Set default colors on a new design page:

1) File/New

2) Set Colors

3) Click on “Make Current Default”

4) Click “Yes”

5) Go to File/New, notice that the new default colors appear.

6) May also click on an empty box on the color bar for the option.

5. Print Preview:  Print Preview screen is set to “Size to Fit” as a default with a new look. 
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6. Eye is sequence view: The eye icon is darker.

7. Drag and Drop: You can Drag and Drop image file in to the center of the work field.

8. Hoops:  Added filtering to the Hoop feature; remove or add a check mark for the desired hoops.



Inspiration Software-Updates

81

9. Jumbo Hoop is now fully supported.

10. New Hoops added:

1) BabyLock-Brother 240x240

2) BabyLock-Brother 270x400

3) BabyLock-Brother 240x360

11. Trim:  A fast way to add a basic trim to the end of an object.

1) Click on object

2) Click on the “trim  Icon”

When using this feature, it will:

1) Add the trim and basic tie off to the end of  
    the selected object.

2) Add basic tie in to the next object.

12. Trim Branches:  A new trim function giving the user more control on how they wish the trims to be 
added.

1) Auto:  		  (default):  Trim if the stitch is longer than 20 mm.

2) Always:  	 Will always trim

3) Never:  	 Will never trim

4) Longer than:  	 User can set the distance



Inspiration Software-Updates

82

13. Special Files:  We have moved Inspirations special files formats out of the standard Open and Save.  
It has its own selection under File called “Special Files”

May, 2019

MFD; Ver. 12.92
New Features:

1. Hi-Resolution Displays:  New hi-resolution toolbar icons for 4K displays.

2. General Options:  New look to Tools/General Options:

3. Default Colors:  Set default colors on a new design page:

1) File/New

2) Set Colors

3) Click on “Make Current Default”

4) Click “Yes”

5) Go to File/New, notice that the new default colors appear.
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6) May also click on an empty box on the color bar for the option.

4. Print Preview:  Print Preview screen is set to “Size to Fit” as a default with a new look. 
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5. Eye is sequence view: The eye icon is darker.

6. Drag and Drop: You can Drag and Drop image file in to the center of the work field.

7. Trim, Weld, Intersect:  These three functions have been moved to “Shaping” and can be used with 
a right click when two objects are selected.
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8. Special Files:  We have moved Inspirations special files formats out of the standard Open and Save.  
It has its own selection under File called “Special Files”.

9. More Efficient Editing:  “Shape F9” now remains in active mode while selecting new objects for editing.  
To return to “Select F7”, left click on Select   icon.

May, 2019

SSP; Ver. 12.92
New Features:

1. Hi-Resolution Displays:  New hi-resolution toolbar icons for 4K displays.

2. General Options:  New look to Tools/General Options:
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3. Default Colors:  Set default colors on a new design page:

1) File/New

2) Set Colors

3) Click on “Make Current Default”

4) Click “Yes”

5) Go to File/New, notice that the new default colors appear.

6) May also click on an empty box on the color bar for the option.

4. Print Preview:  Print Preview screen is set to “Size to Fit” as a default with a new look. 
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5. Eye is sequence view: The eye icon is darker.

6. Drag and Drop: You can Drag and Drop image file in to the center of the work field.
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7. Hoops:  Added filtering to the Hoop feature; remove or add a check mark for the desired hoops.

8. Jumbo Hoop is now fully supported.

9. New Hoops added:

1) BabyLock-Brother 240x240

2) BabyLock-Brother 270x400

3) BabyLock-Brother 240x360

10. Trim:  A fast way to add a basic trim to the end of an object.

1) Click on object

2) Click on the “trim  Icon”

When using this feature, it will:

1) Add the trim and basic tie off to the end of  
    the selected object.

2) Add basic tie in to the next object.
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11. Special Files:  We have moved Inspirations special files formats out of the standard Open and Save.  
It has its own selection under File called “Special Files”.

May, 2019

SSN; Ver. 12.92
New Features:

1. Hi-Resolution Displays:  New hi-resolution toolbar icons for 4K displays.

2. General Options:  New look to Tools/General Options:
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3. Default Colors:  Set default colors on a new design page:

1) File/New

2) Set Colors

3) Click on “Make Current Default”

4) Click “Yes”

5) Go to File/New, notice that the new default colors appear.

6) May also click on an empty box on the color bar for the option.

4. Print Preview:  Print Preview screen is set to “Size to Fit” as a default with a new look. 
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5. Eye is sequence view: The eye icon is darker.

6. Drag and Drop: You can Drag and Drop image file in to the center of the work field.
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7. Hoops:  Added filtering to the Hoop feature; remove or add a check mark for the desired hoops.

8. Jumbo Hoop is now fully supported.

9. New Hoops added:

1) BabyLock-Brother 240x240

2) BabyLock-Brother 270x400

3) BabyLock-Brother 240x360

10. Trim:  A fast way to add a basic trim to the end of an object.

1) Click on object

2) Click on the “trim  Icon”

When using this feature, it will:

1) Add the trim and basic tie off to the end of  
    the selected object.

2) Add basic tie in to the next object.
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11. Special Files:  We have moved Inspirations special files formats out of the standard Open and Save.  
It has its own selection under File called “Special Files”.

May, 2019

MLM; Ver. 12.92
New Features:

1. Hi-Resolution Displays:  New hi-resolution toolbar icons for 4K displays.

2. General Options:  New look to Tools/General Options:
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3. Realistic view option:  (Optional) Increase double and bean run thickness in Realistic view;  
Tools/General Options/View.

4. Default Colors:  Set default colors on a new design page:

1) File/New

2) Set Colors

3) Click on “Make Current Default”

4) Click “Yes”

5) Go to File/New, notice that the new default colors appear.

6) May also click on an empty box on the color bar for the option.
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5. Print Preview:  Print Preview screen is set to “Size to Fit” as a default with a new look. 

6. Eye is sequence view: The eye icon is darker.

7. Drag and Drop: You can Drag and Drop image file in to the center of the work field.
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8. Trim:  A fast way to add a basic trim to the end of an object.

1) Click on object

2) Click on the “trim  Icon”

When using this feature, it will:

1) Add the trim and basic tie off to the end of  
    the selected object.

2) Add basic tie in to the next object.

9. Trim Branches:  A new trim function giving the user more control on how they wish the trims to be 
added.

1) Auto:  		  (default):  Trim if the stitch is longer than 20 mm.

2) Always:  	 Will always trim

3) Never:  		  Will never trim

4) Longer than:  	 User can set the distance
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10. Hoops:  Added filtering to the Hoop feature; remove or add a check mark for the desired hoops.

11. Jumbo Hoop is now fully supported.

12. New Hoops added:

1) BabyLock-Brother 240x240

2) BabyLock-Brother 270x400

3) BabyLock-Brother 240x360

13. Special Files:  We have moved Inspirations special files formats out of the standard Open and Save.  
It has its own selection under File called “Special Files”.
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14. New Digitizing Features: 

Running Stitch Type:

	 Double Rope

	 	

	 Triple Rope

	 	

Fill Type “Grid”:

	 Single
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	 Double

	 	

	 Triple

	 	

May, 2019

PSV:  Ver. 12.92
1. Update file embroidery file formats.
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July, 2018

PEP; Ver. 12.05
New Features:

“French Accents” added to the 11 micro fonts.

Fixes:

Minor program fixes.

July, 2018

MQE; Ver. 12.05
Fixes:

Minor program fixes.

July, 2018

MBP; Ver. 12.05
Fixes:

Minor program fixes.
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July, 2018

PSV; Ver. 12.05
Fixes:

Minor program fixes.

July, 2018

MQP; Ver. 12.05
Fixes:

Minor program fixes.

July, 2018

WAS; Ver. 12.05
New Features:

“French Accents” added to the 11 micro fonts.

Fixes:

Minor program fixes.
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July, 2018

MES; Ver. 12.05
Fixes:

Minor program fixes.

July, 2018

MFD; Ver. 12.05
Fixes:

Minor program fixes.

July, 2018

VE; Ver. 12.05
Fixes:

Minor program fixes.

July, 2018

SSP; Ver. 12.05
Fixes:

Minor program fixes.
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April, 2018

PEP; Ver. 11.21
1. Update Exquisite Thread 40 weight. 

2. Links on Today screen automatically open in the Users Default browser (Chrome, Internet Explorer, 
Edge, etc.)

3. Windows 10 related bug fixes.

New Features:

1. Align outline points option in Shape tool: 

a. Select an object, click on Shape tool

b. Select points – either:

i. Hold down mouse key and drag to select.

ii. Click on the first point, hold the CTRL key and click on other points to select.

c. Right click, select Align

d. Select position



Inspiration Software-Updates

104

2. Shape tool, when editing an angle line, the length and angle are displayed.

3. Better control for digitizing curved lines and satins.  To make a perfect 5 point circle:

a. Select Tools on the Menu Bar

b. Select General Options

c. Select Digitizing

d. Select  Outline input mode:  Simple Draw

e. Place check mark in ‘Curve points as default’ and ‘Circular curves’
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April, 2018

MQE; Ver. 11.21
1. Update Exquisite Thread 40 weight. 

2. Links on Today screen automatically open in the Users Default browser (Chrome, Internet Explorer, 
Edge, etc.)

3. Windows 10 related bug fixes.

4. Better control for digitizing curved lines and satins.  To make a perfect 5 point circle:

a. Select Tools on the Menu Bar

b. Select General Options

c. Select Digitizing

d. Select  Outline input mode:  Simple Draw

e. Place check mark in ‘Curve points as default’ and ‘Circular curves’
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April, 2018

MBP; Ver. 11.21
1. Update Exquisite Thread 40 weight. 

2. Links on Today screen automatically open in the Users Default browser (Chrome, Internet Explorer, 
Edge, etc.)

3. Windows 10 related bug fixes.

New Features:

1. Align outline points option in Shape tool: 

a. Select an object, click on Shape tool

b. Select points – either:

i. Hold down mouse key and drag to select.

ii. Click on the first point, hold the CTRL key and click on other points to select.

c. Right click, select Align

d. Select position
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2. Better control for digitizing curved lines and satins.  To make a perfect 5 point circle:

a. Select Tools on the Menu Bar

b. Select General Options

c. Select Digitizing

d. Select  Outline input mode:  Simple Draw

e. Place check mark in ‘Curve points as default’ and ‘Circular curves’

April, 2018

PSV; Ver. 11.21
1. Windows 10 related bug fixes.
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April, 2018

MQP; Ver. 11.21
1. Update Exquisite Thread 40 weight.

2. Links on Today screen automatically open in the Users Default browser (Chrome, Internet Explorer, 
Edge, etc.)

3. Windows 10 related bug fixes.

April, 2018

WAS; Ver. 11.21
1. Update Exquisite Thread 40 weight. 

2. Links on Today screen automatically open in the Users Default browser (Chrome, Internet Explorer, 
Edge, etc.)

3. Windows 10 related bug fixes.

New Features:

1. Better control for digitizing curved lines and satins.  To make a perfect 5 point circle:

a. Select Tools on the Menu Bar

b. Select General Options

c. Select Digitizing

d. Select  Outline input mode:  Simple Draw

e. Place check mark in ‘Curve points as default’ and ‘Circular curves’

Using PEN under ARTWORK
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April, 2018

MES; Ver. 11.21
1. Update Exquisite Thread 40 weight. 

2. Links on Today screen automatically open in the Users Default browser (Chrome, Internet Explorer, 
Edge, etc.)

3. Windows 10 related bug fixes.

April, 2018

MFD; Ver. 11.21
1. Update Exquisite Thread 40 weight. 

2. Links on Today screen automatically open in the Users Default browser (Chrome, Internet Explorer, 
Edge, etc.)

3. Windows 10 related bug fixes.

New Features:

1. Better control for digitizing curved lines and satins.  To make a perfect 5 point circle:

a. Select Tools on the Menu Bar

b. Select General Options

c. Select Digitizing

d. Select  Outline input mode:  Simple Draw

e. Place check mark in ‘Curve points as default’ and ‘Circular curves’

Using PEN under ARTWORK
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April, 2018

VE; Ver. 11.21
1. Update Exquisite Thread 40 weight. 

2. Links on Today screen automatically open in the Users Default browser (Chrome, Internet Explorer, 
Edge, etc.)

3. Windows 10 related bug fixes.

New Features:

1. Change to Vintage style in Dime Vintage software.

a. Select design or a design element 

b. Right click, select Utility

c. Select Change style. 

2. Better control for digitizing curved lines and satins.  To make a perfect 5 point circle:

a. Select Tools on the Menu Bar

b. Select General Options

c. Select Digitizing

d. Select  Outline input mode:  Simple Draw

e. Place check mark in ‘Curve points as default’ and ‘Circular curves’

Using PEN under ARTWORK
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April, 2018

SSP; Ver. 11.21
1. Update Exquisite Thread 40 weight. 

2. Links on Today screen automatically open in the Users Default browser (Chrome, Internet Explorer, 
Edge, etc.)

3. Windows 10 related bug fixes.

New Features:

1. Better control for digitizing curved lines and satins.  To make a perfect 5 point circle:

a. Select Tools on the Menu Bar

b. Select General Options

c. Select Digitizing

d. Select  Outline input mode:  Simple Draw

e. Place check mark in ‘Curve points as default’ and ‘Circular curves’

Using PEN under ARTWORK
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January 2018

PEP; Ver. 9.75
Fix:  Adjusted Toolbar loading delay for latest Win 10 version.

Features:

1. You can set the outline distance to Nap Blocker 

2. The Nap Blocker option adds a Stop command at the end of the underneath stitches.

3. The default pull-comp setting in Normal style is now Percentage instead of Absolute.
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January 2018

MQE; Ver. 9.75
Fixes:  Adjusted Toolbar loading delay for latest Win 10 version.

January 2018

MBP; Ver. 9.75
Fixes:  Adjusted Toolbar loading delay for latest Win 10 version.

January 2018

WAS; Ver. 9.75
Fixes:  Adjusted Toolbar loading delay for latest Win 10 version.

January 2018

MQP; Ver. 9.75
Fixes:  Adjusted Toolbar loading delay for latest Win 10 version.

January 2018

MES; Ver. 9.75
Fixes:  Adjusted Toolbar loading delay for latest Win 10 version.

January 2018

VE; Ver. 9.75
Fixes:  Adjusted Toolbar loading delay for latest Win 10 version.

January 2018

MFD; Ver. 9.75
Fixes:  Adjusted Toolbar loading delay for latest Win 10 version.
New:  New artworks have been added to the library.
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January 2018

SSN; Ver. 9.75
Fixes:  Adjusted Toolbar loading delay for latest Win 10 version.

November 2017

PEP; Ver. 9.68
New Features:

1. Exquisite Thread 40 & 60 weight added to the Thread Palettes.

2. VP4 format is supported.

3. New emboss settings in PEP:

In complex fills and satins, you can change the orientation and the scale.

In satins, you can also check the ‘Single’ setting making the emboss pattern follow the direction of 

the stitches.

4. Navigator tab is available in PEP.
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November 2017

MQE; Ver. 9.68
New Features:

1. Exquisite Thread 40 & 60 weight added to the Thread Palettes.

2. VP4 format is supported.

November 2017

MBP; Ver. 9.68
New Features:

1. Exquisite Thread 40 & 60 weight added to the Thread Palettes.

2. VP4 format is supported.

November 2017

PSV; Ver. 9.68
New Features:

1. VP4 format is supported.

November 2017

WAS; Ver. 9.68
New Features:

1. Exquisite Thread 40 & 60 weight added to the Thread Palettes.

2. VP4 format is supported.

November 2017

MQP; Ver. 9.68
New Features:

1. Exquisite Thread 40 & 60 weight added to the Thread Palettes.

2. VP4 format is supported.
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November 2017

MES; Ver. 9.68
New Features:

1. Exquisite Thread 40 & 60 weight added to the Thread Palettes.

2. VP4 format is supported.

November 2017

VE; Ver. 9.68
New Features:

1. Exquisite Thread 40 & 60 weight added to the Thread Palettes.

2. VP4 format is supported.

November 2017

MFD; Ver. 9.68
New Features:

1. VP4 format is supported.

November 2017

SSN; Ver. 9.68
New Features:

1. Exquisite Thread 40 & 60 weight added to the Thread Palettes.

2. VP4 format is supported.
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June 2017

PEP; Ver. 9.55
New Features:

1. Filter:  allows the user to show only selected design portions at the object level.

    How it works:

a. Open a design.

b. Left click on Select    (F7).

c. Right click in the middle of the design page.

d. Move to “View”.

e. Click on “Filter” (you don’t have to select any design objects first).

f. Select the object or objects you would like to view.

g. Click OK.

h. To return to the full design, right click on the design page, or “All Items” in the Sequence View;  
    move to “View”; select “Show All”
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Note:  When opening a machine format design, .pes, .vp3, .jef, etc. place a check in  
“Convert to Outlines” in the Open dialog box.

2. Create Nap Blocker:  used to create a foundation for embroidery when stitching on a nap or pile fabric.

    How it works:

a. Open a design.

b. Left click on Select    (F7).

c. Select a potion or the entire design.

d. Right click in the middle of the design page.

e. Move to “Utility”

f. Click on “Create Nap Blocker”
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3. Change Style:  allows the user to select one or more design objects and change the way the selected 
objects sew.  Click2Stitch, changes the entire design, Change Style changes only the selected object(s).  
This is a very powerful tool when used with the Filter option.

    How it works:

a. Open a design on the design page;  
    UnGroup    the design.

b. Left click on Select    (F7).

c. Select a portion or the entire design.

d. Right click in the middle of the screen.

e. Move to “Utility”

f. Click on “Change Style”

    When the Styles dialog box appears, select the new style for the selected object(s).

g. For registered users of PEP and Vintage, “Special” design Styles has been added.   
    Quickly convert selected objects to “Vintage” and select the thread weight.

a. Vintage 15

b. Vintage 40
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4. Change Size or Offset:  new convenient way, using scrollbars, to change the size or the offset of an 
image pattern.

5. Projection:  Add movement to your designs with this new running stitch feature.

    How it works:

a. The user digitizes a running stitch.

b. The projection perspective is based off the first and last data point in the running stitch object.

c. After digitizing the running stitch, select the running object.

d. In the Run Properties box, change Type:  Run to Projection.

e. Click Apply.
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6. Color Application:  Change the mouse click behavior on the color palette.

    How it works:

a. On the Menu bar, click on Tools/General Options/View.

b. Place a check in “Use left click on palette to apply color”.

c. Click OK.

d. Open design on design page; UnGroup    design.

e. Select design object(s).

f. Left click on a color block to apply color change to the selected object(s).

g. Right click to change the Thread Palette

h. Note:  This is the exact opposite of the program color change default.
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June 2017

Vintage Embroidery; Ver. 9.57
New Features:

1. Change Size or Offset:  new convenient way, using scrollbars, to change the size or the offset of an 
image pattern.

2. Color Application:  Change the mouse click behavior on the color palette.

    How it works:

a. On the Menu bar, click on Tools/General Options/View.

b. Place a check in “Use left click on palette to apply color”.

c. Click OK.

d. Open design on design page; UnGroup    design.

e. Select design object(s).

f. Left click on a color block to apply color change to the selected object(s).

g. Right click to change the Thread Palette

h. Note:  This is the exact opposite of the program color change default.
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February 2017

PEP; Ver. 9.43
New Features:

1. Loading progress bar appears on the program splash screen.

2. Dialog box in Carousel, Place, Reflect and Scatter reflects the global unit of measurement.

3. Dime threads, Dime 15 wt and 40wt, added to Thread Chart.

4. The selected hoop name is saved in the .c2s file format. When reading back the design, the hoop 
name appears on the lower right status bar and auto selected in the show hoop dialog.

5. Can read PES Version 9, 10, and Multi positional files. 
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6. Can save PES Version 9. 

7. Support for Brother Multi positional hoops (100x172, 130x300 and Jumbo 360x360).

February 2017

MQE; Ver. 9.41
New Features:

1. Loading progress bar appears on the program splash screen.

2. Dime threads, Dime 15 wt and 40wt, added to Thread Chart.

3. The selected hoop name is saved in the .c2s file format. When reading back the design, the hoop 
name appears on the lower right status bar and auto selected in the show hoop dialog.

4. Can read PES Version 9, 10, and Multi positional files. 

5. Can save PES Version 9.

6. Support for Brother Multi positional hoops (100x172, 130x300 and Jumbo 360x360).
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February 2017

MBP; Ver. 9.41
New Features:

1. Loading progress bar appears on the program splash screen.

2. Dime threads, Dime 15 wt and 40wt, added to Thread Chart.

3. The selected hoop name is saved in the .c2s file format. When reading back the design, the hoop 
name appears on the lower right status bar and auto selected in the show hoop dialog.

4. Can read PES Version 9, 10, and Multi positional files. 

5. Can save PES Version 9.

6. Support for Brother Multi positional hoops (100x172, 130x300 and Jumbo 360x360).
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February 2017

WAS; Ver. 9.41
New Features:

1. Loading progress bar appears on the program splash screen.

2. Dialog box in Bubble Text reflects the selected global unit of measurement.

3. Dime threads, Dime 15 wt and 40wt, added to Thread Chart.

4. The selected hoop name is saved in the .c2s file format. When reading back the design, the hoop 
name appears on the lower right status bar and auto selected in the show hoop dialog.

5. Can read PES Version 9, 10, and Multi positional files. 

6. Can save PES Version 9.

7. Support for Brother Multi positional hoops (100x172, 130x300, Jumbo 360x360). Export/Save is 
available in PEP through Split design dialog.
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February 2017

MQP; Ver. 9.41
New Features:

1. Loading progress bar appears on the program splash screen.

2. Dime threads, Dime 15 wt and 40wt, added to Thread Chart.

3. The selected hoop name is saved in the .c2s file format. When reading back the design, the hoop 
name appears on the lower right status bar and auto selected in the show hoop dialog.

4. Can read PES Version 9, 10, and Multi positional files. 

5. Can save PES Version 9.

6. Support for Brother Multi positional hoops (100x172, 130x300 and Jumbo 360x360).
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February 2017

SSP; Ver. 9.43
New Features:

1. Loading progress bar appears on the program splash screen.

2. Dime threads, Dime 15 wt and 40wt, added to Thread Chart.

3. The selected hoop name is saved in the .c2s file format. When reading back the design, the hoop 
name appears on the lower right status bar and auto selected in the show hoop dialog.

4. Support for PNGs with transparency. 

5. Multiple frame support in SSP Photo Frames. You can now use templates with multiple frames.

6. New Photo Frames in SSP.

7. Can read PES Version 9, 10, and Multi positional files.

8. Can save PES Version 9.

9. Support for Brother Multi positional hoops (100x172, 130x300, Jumbo 360x360). Export/Save is 
available in PEP through Split design dialog.
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February 2017

MFD; Ver. 9.43
New Features:

1. Loading progress bar appears on the program splash screen.

2. New Library files added (Ziba Floral).
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November 2016

PEP; Ver. 9.25
New Features:

1. The application by default creates outlines after reading a stitch file. This is an option now in File 
open dialog.

2. Tools - General options - Grid. Change the view order of the grid and guidelines to show them in front 
of the design. 

3. The application shows different marks for curves and corners now; a square for corners, a circle for curves.

4. The auto outline close in complex fill, or when pressing ‘C’ in input mode for runs, etc, depends on the 
first point type now.   If the first point is a curve it creates a curve; previously the close was a straight line.
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5. The Spiral feature has been added to Text.  Right Click on the word to select.

6. Tools - General options - Digitizing. Option for the default point type in Simple Draw mode; it can be 
either corner or curve.

7. Tools - General options - View. Option to auto close zoom and pan tools.

8. Improved snapping to 45 degrees when pressing and holding the Shift key in input mode.

9. Pressing Shift in Shape tool gives priority to outline editing no matter if angle lines or start/stop points 
are on top. This is useful when editing satin outlines created with the classic satin tool.

10. Short stitches & auto density are available in text paths now.
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11. The Name drops feature supports output to a single file. It creates all texts, one on top of the other, 
in a single file. The texts are centered and separated with Stop commands.

12. The Sequence view supports Groups as separate entities. You can rename the Group by clicking 
twice on the root (like renaming single paths).

13. Hover the cursor over a small icon displays a preview icon.

14. Bring Forward, Send Backward options have been added with handy shortcuts (same as in Adobe 
Illustrator).

15. Magic wand tolerance added to Backdrop Properties.  To view the Magic wand tolerance adjustment 
bar, left mouse click on the    Backdrop tool icon on the left tool bar, placing a selection box around the 
backdrop image and activating the Properties- Backdrop box.
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16. My Fabric Designs icon added to the add-on bar. Icons are displayed for all registered versions of 
software listed in illustration.

17. ‘3D’ view has been renamed to ‘Realistic’.

18. Guidelines.  You can now set custom degrees.

19. New ‘Search’ feature has been added to the Library.  You can add Keywords to designs in Properties-Design; 
click Apply.
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Right click on the word ‘Designs’ in the Library, select ‘Find’ or press Ctrl+F.  You can search for keywords, 
notes and more.

You can include non-native designs to your search (.jef, .pes, etc.).  The initializing is a bit slower the 
first time and the fields Keywords and Notes are only available for the C2S format.

Tip:  Saved ‘Notes and Keywords’ are displayed in the Properties box when the design is dragged and 
released above the Library box.  ‘Notes and Keywords’ are not displayed when the design is dragged 
directly onto an active design page.

20. Tools – General Options – Environment.  New option available to Export Environment (current settings, 
custom thread charts, etc.); you can Import Environment to a new computer.   You can also use it to make 
a backup copy of your settings and custom objects.

21. Copyright fabric patterns are auto removed before Sending to My Fabric Designs.
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November 2016

MQE; Ver. 9.25
New Features:

1. The application by default creates outlines after reading a stitch file. This is an option now in File 
open dialog.

2. General options - Grid. Change the view order of the grid and guidelines to show them in front of the 
design.

3. The application shows different marks for curves and corners now; a square for corners, a circle for curves.

4. The auto outline close of the Artwork Pen tool, when pressing ‘C’ in the input mode, depends on the first 
point type now.  If the first point is a curve, it creates a curve; previously the close was a straight line.
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5. Tools - General options - Digitizing. Option for the default point type in Simple Draw mode; it can be 
either corner or curve.

6. Tools - General options - View. Option to auto close zoom & pan tools.

7. Improved snapping to 45 degrees when pressing and holding the Shift key in input mode.

8. The sequence view supports Groups as separated entities. You can rename the Group by clicking twice 
on the root (like renaming single paths).

9. Hover the cursor over a small icon displays a preview icon.

10. Bring Forward, Send Backward options have been added with handy shortcuts (same as in Adobe 
Illustrator).
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11. ‘3D’ view has been renamed to ‘Realistic’.

12. Guidelines.  You can now set custom degrees.

November 2016

MBP; Ver. 9.25
New Features:

1. The application by default creates outlines after reading a stitch file. This is an option now in File 
open dialog.

2. General options - Grid. Change the view order of the grid and guidelines to show them in front of the 
design.

3. The application shows different marks for curves and corners now; a square for corners, a circle for curves.
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4. The auto outline close of the Artwork Pen tool, when pressing ‘C’ in the input mode, depends on the first 
point type now.  If the first point is a curve, it creates a curve; previously the close was a straight line.

5. Tools - General options - View. Option to auto close zoom and pan tools.

6. Improved snapping to 45 degrees when pressing and holding the Shift key in input mode.

7. The sequence view supports Groups as separated entities. You can rename the Group by clicking twice 
on the root (like renaming single paths).

8. Hover the cursor over a small icon displays a preview icon.

9. Bring Forward, Send Backward options have been added with handy shortcuts (same as in Adobe 
Illustrator).
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10. ‘3D’ view has been renamed to ‘Realistic’. 

11. Guidelines.  You can now set custom degrees.

November 2016

MQP; Ver. 9.25
New Features:

1. The application by default creates outlines after reading a stitch file. This is an option now in File 
open dialog.

2. General options - Grid. Change the view order of the grid and guidelines to show them in front of the 
design.

3. Tools - General options - View. Option to auto close zoom and pan tools.
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4. Improved snapping to 45 degrees when pressing and holding the Shift key in input mode.

5. The sequence view supports Groups as separated entities. You can rename the Group by clicking twice 
on the root (like renaming single paths).

6. Hover the cursor over a small icon displays a preview icon.

7. Bring Forward, Send Backward options have been added with handy shortcuts (same as in Adobe 
Illustrator).

8. ‘3D’ view has been renamed to ‘Realistic’. 

9. Guidelines.  You can now set custom degrees.
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November 2016

WAS; Ver. 9.25
New Features:

1. The application by default creates outlines after reading a stitch file. This is an option now in File 
open dialog.

2. General options - Grid. Change the view order of the grid and guidelines to show them in front of the 
design.

3. The auto outline close of the Artwork Pen tool, when pressing ‘C’ in the input mode, depends on the first 
point type now.  If the first point is a curve, it creates a curve; previously the close was a straight line.

4. Tools - General options - View. Option to auto close zoom and pan tools.
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5. The Spiral feature has been added to Text.  Right Click on the word to select.

6. Tools - General options - Digitizing. Option for the default point type in simple input mode; it can be 
either corner or curve.

7. Improved snapping to 45 degrees when pressing and holding the Shift key in input mode.

8. The Name drops feature supports output to a single file. It creates all texts, one on top of the other, in 
a single file. The texts are centered and separated with Stop commands.

9. The sequence view supports Groups as separated entities. You can rename the Group by clicking twice 
on the root (like renaming single paths).

10. Hover the cursor over a small icon displays a preview icon.
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11. Bring Forward, Send Backward options have been added with handy shortcuts (same as in Adobe 
Illustrator).

12. Appliqué added to outline choices in Bubble Text.

13. ‘3D’ view has been renamed to ‘Realistic’.

14. Guidelines.  You can now set custom degrees.

15. Shapes in Bubble text have been updated.
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November 2016

SSN; Ver. 9.25
New Features:

1. The application by default creates outlines after reading a stitch file. This is an option now in File 
open dialog.

2. General options - Grid. Change the view order of the grid and guidelines to show them in front of the 
design.

3. The auto outline close of the Artwork Pen tool, when pressing ‘C’ in the input mode, depends on the first 
point type now.  If the first point is a curve, it creates a curve; previously the close was a straight line.

4. Tools - General options - Digitizing. Option for the default point type in Simple Draw mode; it can be 
either corner or curve.
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5. Tools - General options - View. Option to auto close zoom and pan tools.

6. Improved snapping to 45 degrees when pressing and holding the Shift key in input mode.

7. The sequence view supports Groups as separated entities. You can rename the Group by clicking twice 
on the root (like renaming single paths).

8. Hover the cursor over a small icon displays a preview icon.

9. Bring Forward, Send Backward options have been added with handy shortcuts (same as in Adobe 
Illustrator).

10. ‘3D’ view has been renamed to ‘Realistic’.

11. Guidelines.  You can now set custom degrees.
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November 2016

MFD; Ver. 9.25
New Features:

1. General options - Grid. Change the view order of the grid and guidelines to show them in front of the 
design.

2. The application shows different marks for curves and corners now; a square for corners, a circle for curves.

3. The auto outline close of the Artwork Pen tool, when pressing ‘C’ in the input mode, depends on the first 
point type now.  If the first point is a curve, it creates a curve; previously the close was a straight line.

4. Tools - General options - Digitizing. Option for the default point type in Simple Draw mode; it can be 
either corner or curve.
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5. Tools - General options - View. Option to auto close zoom & pan tools.

6. Improved snapping to 45 degrees when pressing and holding the Shift key in input mode.

7. The sequence view supports Groups as separated entities. You can rename the Group by clicking twice 
on the root (like renaming single paths).

8. Hover the cursor over a small icon displays a preview icon.

9. Bring Forward, Send Backward options have been added with handy shortcuts (same as in Adobe 
Illustrator).

10. Unlimited image size in exporting from Send dialog.

11. Copyright fabric patterns are auto removed before Sending to My Fabric Designs.
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May 2016

PEP; Ver. 9.04
Update Notice:

The minimum requirement for our software has been changed to Windows 7, Windows 8, Windows 8.1 and 
Windows 10 on ALL software.

New Features:

1. New Mettler thread charts and Glide thread chart added.

2. New artwork settings (width, opacity, dash style, stroke for fills):

3. New Fabric fill settings:
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4. SVG file improvements – ‘Import as Artwork’ supports fills now. ‘Export as Artwork’ saves Bézier 

    outlines instead of simple polylines.

5. Added reading support for the new Janome JPX format.

6. New Viking Designer Epic hoops; Imperial Hoop 360x260, Crown Hoop 260x200, Splendid Square  
    Hoop 120x120.

7. Import Image as object

8. Ctrl+Click on a palette color pop-ups the standard color dialog box. This is an alternative way for  
    setting a specific RGB color instead of a color from a thread chart.

9. Center origin - works on selected objects now

10. Fit in Hoop can also enlarge the design if needed (the hoop margin setting is as always in Machine 
      settings)
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11. 3D effect in complex fill (motif fill type) has been renamed to Dimensional.

12. Show/hide Last Stitch indicator in View Menu.

13. Name drops: Create a text object, add optional decorations and select all. Go to Tools>Name Drops.

There are several options in this dialog. You can import or export names to a text file and set the alignment. 
Also you can select the Fit in Width method to make sure long names won’t go outside a specific area.
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Rectangular and Circular text types are supported in Name Drops. Output example:

14. Guidelines support color and angle now. Using the select tool, right click on a guideline to pop-up  
       the Guideline menu.

15. Vertical text option added:



Inspiration Software-Updates

152

16. Added support for the QLI quilting format.

17. New Artwork shapes (Star, Round, Heart)

18. Lasso tool, can also be activated in the Stitch tool by pressing the “L” key, the same as the Select Tool.

19. Three new candlewicking motifs

20. Improved stitch drawing quality in View.
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May 2016

MQE; Ver. 9.04
Update Notice:

The minimum requirement for our software has been changed to Windows 7, Windows 8, Windows 8.1 and 
Windows 10.

New Features:

1. New Mettler thread charts and Glide thread chart added.

2. New artwork settings (width, opacity, dash style, stroke for fills):

3. New Fabric fill settings:

4. SVG file improvements – ‘Import as Artwork’ supports fills now. ‘Export as Artwork’ saves Bézier outlines  
     instead of simple polylines.
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5. New Viking Designer Epic hoops; Imperial Hoop 360x260, Crown Hoop 260x200, Splendid Square 
    Hoop 120x120.

6. Added reading support for the new Janome JPX format.

7. Ctrl+Click on a palette color pop-ups the standard color dialog box. This is an alternative way for setting 
    a specific RGB color instead of a color from a thread chart.

8. Center origin - works on selected objects now

9. Show/hide Last Stitch indicator in View Menu.

10. Guidelines support color and angle now. Using the select tool, right click on a guideline to pop-up  
       the Guideline menu.

11. Added support for the QLI quilting format.
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12. New Artwork shapes (Star, Round, Heart)

13. Three new candlewicking motifs

14. Improved stitch drawing quality in View
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May 2016

MBP; Ver. 9.04
Update Notice:

The minimum requirement for our software has been changed to Windows 7, Windows 8, Windows 8.1 and 
Windows 10.

New Features:

1. New Mettler threads charts and Glide thread chart added.

2. New artwork settings (width, opacity, dash style, stroke for fills):

3. New Fabric fill settings:

4. SVG file improvements – ‘Import as Artwork’ supports fills now. ‘Export as Artwork’ saves Bézier outlines  
     instead of simple polylines.
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5. New Viking Designer Epic hoops; Imperial Hoop 360x260, Crown Hoop 260x200, Splendid Square 
    Hoop 120x120.

6. Added reading support for the new Janome JPX format.

7. Ctrl+Click on a palette color pop-ups the standard color dialog box. This is an alternative way for setting 
    a specific RGB color instead of a color from a thread chart.

8. Center origin - works on selected objects now.

9. Show/hide Last Stitch indicator in View Menu.

10. Guidelines support color and angle now. Using the select tool, right click on a guideline to pop-up  
      the Guideline menu.

11. Added support for the QLI quilting format.

12. New Artwork shapes (Star, Round, Heart)

13. Improved stitch drawing quality in View.
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May 2016

MQP; Ver. 9.04
Update Notice:

The minimum requirement for our software has been changed to Windows 7, Windows 8, Windows 8.1 and 
Windows 10.

New Features:

1. New Mettler thread charts and Glide thread chart added.

2. New Viking Designer Epic hoops; Imperial Hoop 360x260, Crown Hoop 260x200, Splendid Square  
    Hoop 120x120.

3. Added reading support for the new Janome JPX format.

4. Ctrl+Click on a palette color pop-ups the standard color dialog box. This is an alternative way for setting  
    a specific RGB color instead of a color from a thread chart.

5. Show/hide Last Stitch indicator in View Menu.

6. Guidelines support color and angle now. Using the select tool, right click on a guideline to pop-up the 
    Guideline menu.
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7. Three new border types. Also the quilt object can support up to 5 borders now.

8. Square block shape:

9. In diamond block shape you can easily set the diamond side now:

10. New tool to set the cell color directly in the design window:
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11. Make a design not repeatable using the following button:

12. Improved stitch drawing quality in View.

May 2016

SSN; Ver. 9.04
Update Notice:

The minimum requirement for our software has been changed to Windows 7, Windows 8, Windows 8.1 and 
Windows 10.

New Features:

1. New Mettler thread charts and Glide thread chart added.
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2. New artwork settings (width, opacity, dash style, stroke for fills):

3. New Fabric fill settings:

4. New Viking Designer Epic hoops; Imperial Hoop 360x260, Crown Hoop 260x200, Splendid Square 
    Hoop 120x120.

5. Added reading support for the new Janome JPX format.

6. Ctrl+Click on a palette color pop-ups the standard color dialog box. This is an alternative way for setting  
    a specific RGB color instead of a color from a thread chart.

7. Center origin - works on selected objects now

8. Show/hide Last Stitch indicator in View Menu.
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9. Guidelines support color and angle now. Using the select tool, right click on a guideline to pop-up the  
    Guideline menu.

10. New Artwork shapes (Star, Round, Heart)

11. Improved stitch drawing quality in View
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May 2016

WAS; Ver. 9.04
Update Notice:

The minimum requirement for our software has been changed to Windows 7, Windows 8, Windows 8.1 and 
Windows 10.

New Features:

1. New Mettler thread charts and Glide thread chart added.

2. New artwork settings (width, opacity, dash style, stroke for fills):

3. New Fabric fill settings:

4. SVG file improvements – ‘Import as Artwork’ supports fills now. ‘Export as Artwork’ saves Bézier outlines  
    instead of simple polylines.
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5. Added reading support for the new Janome JPX format.

6. New Viking Designer Epic hoops; Imperial Hoop 360x260, Crown Hoop 260x200, Splendid Square  
    Hoop 120x120.

7. Ctrl+Click on a palette color pop-ups the standard color dialog box. This is an alternative way for setting 
    a specific RGB color instead of a color from a thread chart.

8. Center origin - works on selected objects now

9. Show / hide last stitch indicator in View menu

10. You can now use tilde symbol to keep words together in WAS. Example: New~York City

11. Name drops: Create a text object, add optional decorations and select all. Go to Tools>Name Drops.

There are several options in this dialog. You can import or export names to a text file and set the alignment. 
Also you can select the Fit in Width method to make sure long names won’t go outside a specific area.

Rectangular and Circular text types are supported in Name Drops. Output example:
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12. Guidelines support color and angle now. Using the select tool, right click on a guideline to pop-up the  
       Guideline menu.

13. Vertical text option added:

14. New Artwork shapes (Star, Round, Heart)

15. Improved stitch drawing quality in View.
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January 2016

PEP; Ver. 8.66:
Add-ons bar in PEP: Icons have been added to the right side of the  
PEP screen for registered owners of MQE, MBP, MQP and/or WAS;  
simply click on your Inspiration Software program icon to access the  
program and create your project all on one screen without opening  
several programs. For additional program options, simply click on the  
arrow under the program icon.

Artboards: Artboards have been added to  
the Save as option. You can add artboards  
to a design to define multiple hoop areas or  
to export smaller portions from the main design.  
Place a √ check mark in Artboard in the Artwork  
Properties box before drawing the artwork shape,  
or select the artwork shape, select Artboard,  
click Apply.

You can change the artboard labels in the  
Sequence View to rename the portion selected.  
In File/Save as, select “Use Artboards” to export  
multiple designs.

 Notes: text alignment in Notes text box has been added.

PEP, MQE, WAS; Ver. 8.66: Color change between words has  
been added to the Circle Text option on the Commands tab  
in the Properties Box.
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All Inspiration Software Programs, version 8.66

The Software registration/activation process has been streamlined. Each serial number may be activated 
one time via the web for each software program. To receive a second activation, contact the Support Desk 
(on top menu bar: Help/Software Support in each software package). After this request, the system will 
automatically allow you to unregister from one of your computers and then register/activate a new  
computer for the registered software owner without contacting the Support Desk.

Only the registered owner may use 2 computers with activated software as per the license agreement. 
If the registered owner wishes a second activation for a second computer, in accordance with the 
license agreement, the registered owner must contact the Support Desk as described above.

Snap to Grid, it is now easier to create quilt blocks and edit designs with this  
new update. If you are close to the horizontal or vertical grid or guidelines,  
the point, object or design selection automatically snaps to the nearest grid or  
guideline.

Design Library: When dragging a design from the design library to the  
design page, the design is merged on the active page. When the design is  
moved outside the active area of the design page, it is opened on a new  
design page. Illustration: the design is moved into the Properties box; the  
mouse button released and the design is opened on a new design page.

Brother hoop 240 x 360mm has been added to all Inspiration Software Programs

HQV format has been added to Inspiration Software Programs that support, read and write  
quilting formats.

My Quilt Planner, Ver. 8.66:  Block marks icon has been  
added to the top tool bar. Remove Quilt option is located  
under the arrow on the  Quilt Icon.

Word Art in Stitches; Bubble Text Ver. 8.66: All letters are generated when fonts with capital letters 
only are selected and typed as upper and lower case.

My Quilt Embellisher Ver. 8.66: DFX has been added to Open and Save options.
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August 31, 2015

Word Art in Stitches, Ver. 8.54
New Shape and Décor Designs!

14 Shape designs

269 Décor designs
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July 2015

Perfect Embroidery Pro, Ver. 8.47
1.  Auto match threads when loading .c2s designs; default thread brand is displayed in the Sequence View.

2.  The ‘Today’ page shows up large enough in Microsoft Surface. 

3.  The warning when saving PES designs larger than 200 x 300 (or 300 x 200mm)

4.  Added support for putting ‘Color changes” instead of “Stops” in appliqué. ‘Stops’ work fine for the  
     majority of the machines by creating 3 identical colors; however some machines (like some Bernina     
     models) ignore the color changes. With the new ‘Change color” settingin Appliqué Properties these  
     machines are forced to stop between colors. In the illustration, the tack down line color is changed. 

5.  Added ‘Break up’ support for Buttonholes. The result is 2 grouped outline objects; one for the button   
     hole and a second for the decoration. Each element may be edited separately.
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My Block Piecer, Ver. 8.48
1.  Added support for holes in Cutter tool.

2.  Added support for Brother FCM Import (File>Import Artwork)



Inspiration Software-Updates

171

Perfect Stitch Viewer, Ver. 8.40:
Fixes: Resolved the icon view with PSV and PEP. Click on the Perfect Stitch Viewer icon on your 
desktop, click on Check for Updates.

Perfect Embroidery Pro, Ver. 8.40:
Brother machine occasionally failed to read PES files created from designs with Stop Commands; this 
has been fixed.

New:

1.  Juki .m3 format has been added

2.  Two line circular text feature added: Type text on two lines, select the Circle option, Click Apply.

Improvements: 

Text Design fonts: Scr43133 – Scr43158 have been updated. When updating PEP, download and install 
the Support Files as well or go to http://HereToHelp.InspirationSupport.com and submit a ticket 
requesting the support files.

My Quilt Embellisher and My Block Piecer Ver. 8.33
Fixes: minor fixes to software
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February 2015 Program Updates:

Perfect Embroidery Pro. Ver. 8.33:

Fixes:

1.  Control Key / duplication. (Select the element; left click on the Duplicate icon. Hold down the 
     keyboard Ctrl key, left click on the design page to generate an exact duplicate of the element)

2.  Show/Hide eye icon in Sequence View is now working properly.

New:

1.  New button holes with decorations

2.  Touch options (touch screen)

Improvements (stitch generations)

1.  Better maze type stippling. It creates a single run with no trims and no border cropping; it doesn’t 
     create trims even with fills with holes. You can still select the ‘Hilbert’ and ‘Piano’ stippling types to get 
     the old style border.

2.  Better motif fills; motif fills with HOLES, it, in general, creates less trims than before.
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My Block Piecer Ver. 8.30
Fixes:

1.  Control Key / duplication. (Select the element; left click on the Duplicate icon. Hold down the  
     keyboard Ctrl key, left click on the design page to generate an exact duplicate of the element)

2.  Show/Hide eye icon in Sequence View is now working properly.

Improvements:

1.  Improved Work Flow engine

New:

1.  More blocks added.

My Quilt Embellisher Ver. 8.30
Fixes:

1.  Control Key / duplication. (Select the element; left click on the Duplicate icon. Hold down the  
     keyboard Ctrl key, left click on the design page to generate an exact duplicate of the element)

2.  Show/Hide eye icon in Sequence View is now working properly.

Improvements (stitch generation):

1.  Better maze type stippling. It creates a single run with no trims and no border cropping. 
     It doesn’t create trims even with fills with holes.

2.  Better motif fills; motif fills with HOLES, it, in general, creates less trims than before.
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Perfect Embroidery Pro 8.27
Fixes:

1.  Beads Browse Catalog - the title says ‘Bead’ now instead of ‘Button Hole’

2.  Keep aspect ratio’ in Scatter is fixed now.

Improvements:

1.  Smoother icons
2.  Monogram, Motif and Applique designs buttons are menu items now (under Text designs)
3.  Lasso button is a menu item now (under select tool)

New features:

1.  Buttonholes

Perfect Embroidery Pro 8.23 

Fixes:

1.  Janome thread chart has been updated with new thread codes
2.  Added support for Microsoft Surface tablet
3.  ‘Auto resequence by color’ in Scatter, Shape & Reflection template is working now
4.  C2S file associations work as expected now. 
     Note: The new PEP fixes the problem the first time it runs. Then double clicking on .c2s files should be
5.  working fine.

6.  Converting Complex fills, etc. to Artworks is working now

Improvements:

1.  Improved 3D view

2.  The setup doesn’t reset the program’s settings

New features:

1.  Beads
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Perfect Stitch Viewer 8.21
Fixes:

1.  PSV icons appear in PEP and other programs now. You need to install the PSV v8.21.

Improvements:

1.  Registration dialog in PSV

Inspirations Software 8.15 version
Here are the updates that we have worked on/added for this month in the Tools area:

1.  Reflection template added

2.  Shape template added

3.  Scatter template added

4.  New advanced options in Repeat design take a look!

We have added new designs in Free design of the Month!
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Inspiration Software – Perfect Embroidery Pro v8.14
October Updates

Wow! October’s free updates in Perfect Embroidery Pro are amazing.

3D motif

The 3D motif feature transforms simple shapes with a click of the mouse. When applied, the motif filled 
areas appear to pop off the screen or fabric. The motifs are largest in the center and gradually get 
smaller towards the edges of a design.

When would you apply the 3D feature? My first thoughts include Christmas ornaments, balls, spheres, 
Easter eggs,sun, moon, buildings in landscapes, and flower centers. The feature is not limited to ovals, 
circles and rectangles.In fact, anything that can be converted to a complex fill can be morphed with the 
3D feature.

Variable size motifs in run path

Not only applicable to filled shapes, variable size can also be applied to a run path. Perfect for neckline 
adornments, fireworks or burst designs.
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Inspiration Software – Perfect Embroidery Pro v8.14
Search in catalogs

All catalogs (blocks, fabrics, applique shapes, text designs, etc) are now searchable. Click on the  
catalog (accessed by its corresponding icon) and enter the search term. Click on the up/down arrows 
to jump to the first match.

Placement marks for hoops

Placement marks or stitch marks can now be added to any location in a design. Helpful for creating 
continuous embroidery designs, placement marks identify the point of connection between two designs 
and are removable after the embroidery process is complete.
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Inspiration Software – Perfect Embroidery Pro v8.14
PNG image

PNG images are a more versatile image format than standard jpg files. When saving a design as a 
PNG image, you can change the resolution of the design and select a transparent background. These 
features produce a more sophisticated image when communicating with customers, students or other 
embroiderers.

Enhanced Zoom Feature

In addition to the traditional methods of enlarging the image on the screen (magnifying glass icon and 
the percentage box), now there’s a time saving keyboard shortcut. Position the cursor on a specific 
point, hold down the CTRL key and roll the wheel on the mouse to zoom.

Add a Note to an embroidery file

When selected, the notepad icon lets you type a message in the sewing field of the design. Just type 
the message and it appears on the screen. You can relocate the message to any area within the design, 
resize the note and change the font.



Inspiration Software-Updates

179

Perfect Embroidery Pro Version 7.52
New features now available in the Perfect Embroidery Pro 7.52 update: 
For complete details and illustrations, click on the Online Manual button on the My Inspiration Today 
Page; this page is available when connected to the Internet. On the Pure Inspiration page, click on the 
plus sign (+) in front of Perfect Embroidery Pro; select New Inspiration in Perfect Embroidery.

Inspiration Design Library:  Includes 300 designs provided by Great Notions.

Design Conversion & Artwork Tools: convert designs and export artwork in five formats, .SVG for 
Silhouette™; .AI, .PLT, .DXF and .FCM for Brother Scan & Cut™. Export Artwork is a “save as” function 
and only the artwork is saved; click on File>Export Artwork. 
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Mini Fonts for Small Lettering: The mini font collection consists of 10 new fonts ranging from 3 to 6 mm. 
The mini fonts are designated by the lower case m preceding the font name in the Font Library. 

Click2Stitch Stabilizer and Hooping Companion: With the design on the design page, select 
File>Click2Stitch from the drop down menu. Answer a few simple questions about the design and  
fabric; the design is modified to fit the fabric type and specific hooping and stabilizing recommendations 
are also provided.

One Click Thread Brand Conversion: Click on the Change Palette      icon, located on the right 
side of the color and thread selection tool bar under the design page.

1.  Click on the down arrow to display the thread brand dialog box. 
2.  Click on the new brand. 
3.  Click OK to accept the changes and close the dialog box.
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Center Origin Features: Moves the design to the center of the design page with full design view.  
Right  click on the ruler bar, located across the top of the design page or down the left side, select  
Center Origin.  The design is centered and fully displayed on the design page.

Placement Mark Feature: Placement marks are used to align or match up subsequent hoops or  
anytime when perfect placment is required.  Click on the Placement Marks      icon; select any  or all of 
the eight different alignment marks.  The placement marks are listed in first position in the Sequence 
View.
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Split Designs:

When a design is too large for the selected hoop size, Professional Embroidery Pro has two solutions.

1.  Click on the down arrow under the Hoop  icon, select Auto Fit. This tool transforms the size of the 
     design to fit the selected hoop size.

2.  If the design is smaller than desired, select the Split Design • tool. This tool divides a design into 
    stitchable segments for the designated hoop.
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My Quilt Embellisher Version 7.52
New features now available in the My Quilt Embellisher 7.52 update: 
For complete details and illustrations, click on the Online Manual button on the My Inspiration Today 
Page; this page is available when connected to the Internet. On the Pure Inspiration page, click on the 
plus sign (+) in front of My Quilt Embellisher; select New Inspiration in My Quilt Embellisher.

Unleash the Inner Quilt Designer Within YOU!

Audition your fabrics, blocks and appliqué with DIME’s new Inspired Fabric Library, shared with My 
Quilt Embellisher, My Block Piecer and Perfect Embroidery Pro. To open the Fabric Library, click on the 
Fabric    icon on the tool bar.
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My Block Piecer ‐ Version 7.52
New features now available in the My Block Piecer 7.52 update: 
For complete details and illustrations, click on the Online Manual button on the My Inspiration Today 
Page; this page is available when connected to the Internet. On the Pure Inspiration page, click on the 
plus sign (+) in front of My Block Piecer; select New Inspiration in My Block Piecer.

Unleash the Inner Quilt Designer Within YOU!

Audition your fabrics, blocks and appliqué with DIME’s new Inspired Fabric Library, shared with My 
Block Piecer, My Quilt Embellisher and Perfect Embroidery Pro. To open the Fabric Library, click on the 
Fabric    icon on the tool bar.


